
From the Editor:
This month’s issue features the usual SIG meeting reports and extensive coverage of the latest 
version of the Macintosh operating system, Mac OS X 10.6, also known as Snow Leopard. A couple of 
Snow Leopard articles are reprinted here, but be sure to check out the Hot Links section which has a 
slew of links to Snow Leopard-related info, including advice on how to install it and several reviews 
from major media sources. (For the Apple’s official Snow Leopard website, click here). Apple also 
released what may be the final update to Leopard: 10.5.8. See the article in this issue for details.

On the music front, Apple released iTunes 9 and new iPods, so I’ve included a review of the new 
iTunes features plus several links to iPod info.

Ron Heck, Publications Director
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Meeting Locations and Leaders
 Meeting  Location  Leader
 Board of Directors  Merriam Park Library, 1831 Marshall Ave, St Paul  Bruce Thompson, 763-546-1088

 FileMaker Pro SIG  Partners, 2250 Terminal Rd, Roseville  Steve Wilmes, 651-458-1513

 iWork/AppleWorks
 SIG

 Penn Lake Library, 8800 Penn Ave. S., Bloomington  John Hunkins Sr, 651-457-8949

 Mac OS X SIG  The Foundation, 311 7th Ave N, Minneapolis  Bob Demeules, 763-559-1124
 Mac Q&A SIG  Merriam Park Library, 1831 Marshall Ave, St Paul  Les Anderson, 651-735-3953

 Macintosh
 Consultants SIG

 Good Day Café, 5410 Wayzata Blvd, Golden Valley  Bob Demeules, 763-559-1124

 TC Photoshop User
 Group*

 Minneapolis College of Art & Design, Auditorium
 150, 2501 Stevens Ave S, Minneapolis

 Jeff Tranberry, phone number not
 available

 VectorWorks SIG*  CJR Office, 4441 Claremore Dr, Edina  Charles Radloff, 952-941-1667
* This SIG is NOT sponsored by mini’app’les; the listing is provided as a service to members.This SIG is NOT sponsored by mini’app’les; the listing is provided as a service to members.This SIG is NOT sponsored by mini’app’les; the listing is provided as a service to members.

Meeting Calendar – October 2009Meeting Calendar – October 2009Meeting Calendar – October 2009Meeting Calendar – October 2009
Monday Oct. 5 7:00 pm Board of Directors Meeting
Tuesday Oct. 6 7:00 pm Mac OS X SIG

Wednesday Oct. 7 6:30 pm iWork/AppleWorks SIG
Wednesday Oct. 14 7:00 pm VectorWorks SIG*
Wednesday Oct. 14 7:00 pm TC Photoshop User Group*

Thursday Oct. 15 7:00 am Macintosh Consultants SIG
Thursday Oct. 22 7:00 pm FileMaker Pro SIG
Monday Oct. 26 7:00 pm Mac Q&A SIG

Website: http://www.miniapples.org Forums: http://miniapples.77.forumer.com Email: miniapples@mac.com

http://store.apple.com/us/product/MAC_OS_X_SNGL
http://store.apple.com/us/product/MAC_OS_X_SNGL
http://www.miniapples.org
http://www.miniapples.org
http://www.miniapples.org
http://www.miniapples.org
http://miniapples.7.forumer.com
http://miniapples.7.forumer.com
mailto:miniapples@mac.com
mailto:miniapples@mac.com


TABLE OF CONTENTS
.................................................................................................................................Erik Knopp Retires 2

...........................................................................................iWork/AppleWorks SIG of September 2009 3
..............................................................................................................OS X Meeting of Sept. 1, 2009 5

.......................................................................................................................Q&A SIG of August 2009 6
..........................................................................................More Hidden Refinements in Snow Leopard 7

....................................................................................................Peering Inside Snow Leopard Security 9
.........................................................................iTunes 9 Refines Crowdsourcing and Sharing Features 12

........................................................................................................................Hot Links of the Month 14
.................................................................................................................Members Helping Members 16

....................................................................mini’app’les Membership Application and Renewal Form 17
...................................................................................................Benefits of mini’app’les Membership 17

...............................................................................................................................Board of Directors 18

Submissions
We welcome newsletter submissions from 
members. Perhaps you’re using new software 
that you just can’t live without. Maybe you 
have a new piece of hardware that you find 
extremely useful and of high quality. On the 
other hand, you might be struggling with 
problematic software or hardware.
Why not share your experience with other 
members by writing a product review? Doing so 
may steer others towards quality products or help 
them avoid the problems you may be having.
You can E-mail your submissions to 
ronheck@comcast.net. Submissions must be 
received by the 15th day of each month to be 
included in the next month’s newsletter. I am 
happy to help clean up any articles submitted 
for publication in this newsletter.

SIG Reports
If you don’t see a report from your favorite 
Special Interest Group (SIG) in this issue of the 
newsletter, please take a few minutes to provide 
a summary of the next meeting for the next 
newsletter.
Hopefully, understanding what material and 
what level of material is being discussed at the 
different SIG meetings will encourage more 
people to attend SIG meetings and to join the 
mini’app’les. Thanks for your help.

Erik Knopp Retires
By Les Anderson

Erik Knopp has been mini’app’les  Membership 
Coordinator for the past 12 years and he has 
decided to step down from this position. As 
Membership Coordinator he maintained the 
club membership database, sent out renewal 
notices, and deposited the dues checks.

When we had a printed Newsletter, Erik also 
printed the mailing labels. I’m sure many 
members don’t realize all the work that goes on 
“behind the scenes.” We owe Erik a big Thank 
You, and a pat on the back for all he has done.

Replacing Erik as Membership Coordinator is  
Sandy Foderick; she can be reached at 
sfoderick@mac.com. If the name sounds familar 
it’s because she is the Editor of the Apple User 
Group Bulletin. You can find it on the 
mini’app’les Forum in the Members Private 
Forum: http://miniapples.7.forumer.com.

Sandy is heavily involved with Apple Computers. 
She was the former chair and is a current member 
of Apple’s User Group Advisory Board. She also is 
a long term member of mini’app’les.

In real life she teaches Humanities and 
communications at Argosy University in Eagan, 
and she is the chair of their Institutional Review 
Board. She is also a mom to four Mac users.

I know our membership is in very capable 
hands. When you see Sandy be sure to thank 
her for her service.
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iWork/AppleWorks SIG of September 2009
by Harry Lienke

In September the iWork/
AppleWorks Special Interest 
Group (SIG) met in Saint Paul 
for the first time. The meeting 
began with Harry answering 
a question concerning back-
ups of iCal and Address Book 
data and Safari bookmarks. He pointed out that 
complete sets of back-up information for iCal 
and Address Book are saved using File > Back 
Up iCal… and File > Export > Address Book 
Archive…, respectively. One must copy the file 
at UserName/Library/Safari/Bookmarks.plist to 
create a back-up for Safari bookmarks.

A call for announcements brought forth the 
news of the release of OS X 10.6, also known as 
Snow Leopard. Someone pointed out the 
software was available for $29 at the Apple 
Store and $25 at Best Buy. It was reported the 
installation is accomplished by clicking on a 
single button.

At this meeting our friendly 
facilitator, Pam Lienke, continued 
our introduction to Numbers, the 
spreadsheet component of iWork. 
She launched Numbers ‘09 from 
the dock and accessed the Template 
Chooser (depending on your Preferences 
setting, the Template Chooser opens 
automatically when Numbers starts or can be 
selected from the File Menu). Pam again 
showed the variety of templates available and 
how the individual pages of each template can 
be previewed by scrolling the cursor across the 
thumbnail view of each template. The slider at 
the bottom of the Template Chooser is used to 
expand the thumbnails so more detail is visible 
on each page.

Pam selected the “Event Planner” template. She 
showed how to change the placeholder text in a 
heading (triple-click to select all the text in the 
text box and then enter the new text).

She inserted new pictures in media 
placeholders by dragging the images from the 
Finder and by selecting Insert > Choose from 
the Menu and then navigating through the 
Finder windows to the image(s) of interest. It 
was pointed out that the characteristics of the 
image can be adjusted within Numbers using 
the Adjust Image window (View > Show Adjust 
Image). Someone commented that the Media 
button on the toolbar can be used to access the 
iPhoto library, movies, and audio clips. A 
variety of frames can be utilized to enclose each 
image; select the Inspector and then the Graphic 
Inspector (its button has a square with a circle 
covering the upper right corner of the square) 
and select Picture Frame from the Stroke section 
of the window.

Pam’s next feat of legerdemain was dragging 
contact information from the Address Book and 
having the information appear in a table. Next 
came the disclosure that some data being 
calculated in one table was based on data 
appearing in another table. What will those 
wizards at Apple think of next?

Pam revealed she modified this template to help 
plan Christmas Dinner 2008 for the Lienke 
household.

Someone asked a question about the Home 
Inventory template so we spent a few minutes 
investigating it.

Moving on to Pages ‘09 because an 
attendee was interested in 
brochures, Pam used the Template 
Chooser to quickly review a few of 
the templates. She decided to 
work with the “Elegant Brochure.” 
Pam worked with linking and unlinking text 
boxes and discovered that when two text boxes 
with text in them were linked and then 
unlinked, the text all migrated to the first text 
box. Pam sized, positioned, and cropped the 
images in the template; it was pointed out that 
the size of a Pages document that contains 
images may be reduced with the Reduce File 
Size command on the File menu.
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Pam placed a 
frame around one 
of the graphics 
and showed how 
to change the size 
and color of the 
frame. She opened 
the Colors 
Window by 
clicking the Color 
Well in the Format 
Bar. Here she 
showed us how to 
use the search icon 
(the little 
magnifying glass) 
to pick a color 
from the image 
and change the frame to an identical color; she 
stored the custom color in the palette at the 
bottom of the Colors window. Two questions 
popped up:  1) How can a custom color be 
deleted from the palette; 2) Can anything be 
done to help remind us where a custom color 
was used (there are 260 possible custom colors)?

After some experimentation on the part of the 
Peanut Gallery (many of the attendees brought 
their laptop computers), we determined a 
custom color is deleted if you drag a blank 
square onto the color to be eliminated. 
Somehow Ron Heck discovered (we think he 
cheated by consulting the Help Files) the Color 
Palettes window by clicking on the middle icon 
near the top of the Colors Window; here you 
have access to four standard color palettes plus 
the ability to create and name your own custom 
palettes with custom colors. This is a 
tremendously useful capability we did not 
know iWork ‘09 has. We can now save a custom 
color and label it so we can use it again and 
again in the future.

Since brochures need to be folded somewhat 
precisely, folding markers should be 
strategically placed on the brochure. 
Suggestions made included putting small lines 
on the document and using periods in carefully 

positioned text boxes; in either case, the font can 
be lightened to make the folding marker less 
noticeable.

Pam mentioned her preference for creating 
documents in Full Screen mode and showed 
how to access menus, thumbnails, and the scroll 
bar; she also recommended changing the 
background color to something lighter than the 
default color.

An attendee pointed out that the Pages 
keyboard shortcuts for Zoom In and Zoom Out 
require the Shift key while Zoom in Safari, for 
example, does not require use of the Shift key.

Our final lesson for the evening involved 
locking text boxes and images so they are not 
changed accidentally, grouping text boxes and 
images so they move together, and 
combinations of those operations.

The iWork/AppleWorks SIG will meet next at 
the Penn Lake Library, 8800 Penn Ave. S, in 
Bloomington. The meeting will commence on 
October 7, 2009, at 6:30 pm and will conclude by 
7:45 pm. Next month Pam plans to show some 
things about Numbers formulas and the use of 
Instant Alpha.
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OS X Meeting of Sept. 1, 2009
by Bruce Thompson

The OS X meeting was all about 
Snow Leopard. In case you have 
been hiding under a rock, Apple 
introduced Snow Leopard (OS X 
10.6) on Friday, August 28, 2009, about a month 
earlier than had been expected. Bob Demeules, 
the SIG leader, had it installed on his computer 
and a couple of the other attendees also had it.

Bob said the install went smoothly and took 
about 45 minutes. The install process is a little 
different than in the past. Apple has essentially 
eliminated the “Archive and install” and the 
install is now an (extensive) upgrade process. 
The end result is an operating system that really 
doesn’t look much different but has a number of 
changes “under the hood.” It should be pointed 
out that Snow Leopard is for Intel-based Macs 
only.

OS X is now nearly a full 64-bit operating 
system and the installed Apple applications 
(e.g., Safari and Mail) are now fully 64-bit. 
While there have been some minor 
compatibility problems with other applications 
(see http://support.apple.com/kb/HT3258 for 
the latest listing), Bob said he had not run into 
any problems. If your software is on the list, it 
will most likely 
be updated soon. 
The early release 
also caught some 
developers by 
surprise. Note 
that the installer 
does a check to 
verify that 
previously 
installed 
applications are 
compatible and 
isolates those 
that are not.

Bob went on to describe some of the internal 
changes for Snow Leopard. One thing that has 
changed is the amount of space it takes on your 
disk (less!). The reasons are twofold. First, 
Apple has changed how they calculate a 
gigabyte. Where it used to be a gigabyte was 
defined as 2^30 (1,073,741,824) bytes , it is now 
defined as 10^9 (1,000,000,000) bytes. The result 
is that, while your 200 GB drive showed maybe 
180 GB available, it will now show more than 
190 GB. You don’t really have any more space, it 
just gets calculated differently.

The other change actually does result in more 
space. The applications are now stored in a 
compressed format. The theory behind this is 
that since processor speed has advanced more 
than disk read speed, it is faster for the 
processor to expand the application than it is to 
read a larger file from disk. Bob noted that it 
seemed from his limited experience that his 
laptop was a bit snappier, especially with the 
Apple applications. [Editorʼs Note: Another reason 
the new OS uses less space is that the PowerPC 
code has been deleted.]

While Apple has said all along that this was 
going to be a performance upgrade and not a 
features upgrade, there are a few things that 
have been added. Exposé is now accessible from 
the dock icon of an application. When you click 
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on the dock icon of an open application, all 
windows of that application become available. 
Also, when a window is minimized into the 
dock, it can now minimize into the application 
icon rather than a separate icon on the end of 
the dock. Apple has added system-wide auto-
complete/auto-correct features to Apple 
applications and they will be added to other 
applications in the future.

One of the other major changes is to QuickTime. 
While there are additions to QuickTime X (such 
as the ability to record and edit screen activity 
as a movie), there are also limitations such as 
the inability to play QuickTimeVR. The look has 
also changed. Whether you like it or not is a 
personal preference.

Finally, the Rosetta engine (used for some older 
applications) is not installed by default. You can 
either install it by clicking the “Options” button 
at install or, if you are not sure if you need it, it 
will install “on demand” when an application is 
launched that requires it.

Bob then went into a complex discussion of 
how the code was compiled and how it makes 
better use of the multiple processors. Suffice it 
to say that Apple has put a lot of time and 
development effort into making this version of 
OS X faster, cleaner, and more secure. The 
meeting then adjourned to the Pie SIG at 
Perkins.

Q&A SIG of August 2009
By Les Anderson

We had nine people attending 
including one visitor who joined 
during the meeting. Some of the discussion 
centered around a Java Script error in Firefox. 
The member said he didn’t have the problem in 
Safari. 

Another question dealt with setting PowerPoint 
to automatically advance to the next slide.

We also discussed the need for file backup on 
your computer. It’s a known fact that hard 
drives fail and data is lost. The easiest way to 
back up is to use another hard drive. It could be 
another internal drive or an external drive that 
connects via USB or Firewire. A high capacity 
external drive is less than $100 on sale. 
Shareware/freeware programs such as Carbon 
Copy Cloner or SuperDuper make it easy to 
back up important files. Their programs can be 
downloaded at www.versiontracker.com.
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More Hidden Refinements in Snow Leopard
by Jeff Carlson  and Glenn Fleishman 

Mac OS X 10.6 Snow Leopard doesn’t feature 
many major new features (see “What’s New in 
Snow Leopard,” 2009-08-27), but it does 
incorporate hundreds of tiny changes that can 
affect how you use your Mac on a daily basis. 
Here, we note some refinements that we feel are 
noteworthy beyond what Matt already covered.

Time for Password — A subtle change in the 
Security preference pane can affect laptop users. 
The first option under the General preferences 
now lets you set an amount of time before the 
Mac requires a password after going to sleep or 
engaging the screen saver. In Leopard, the 
option was simply to require the password or 
not. Choose among several increments between 
5 seconds and 4 hours. [JLC]

Smart Eject — Two of the most irritating long-
term problems in Mac OS X have finally been 
eradicated in Snow Leopard: knowing when the 
system has ejected a hard drive, thumb drive, 
disk image, or network drive; and knowing 
why it sometimes refuses to eject a disk.

Snow Leopard adds a visual cue to let you 
know an eject is in process: it dims the disk’s 
icon. This lets you know that something is 
happening. When ejection is complete, the disk 
icon disappears from the Desktop.

If Snow Leopard cannot eject the disk because 
an application or process is accessing or has 
open a document on the mounted volume, it 
displays a dialog that tells you which program 
or system component is in use. Previously, 
you’d have to use the lsof command via 
Terminal and learn to understand the results.

And even better, a Force Eject button lets you 
override Mac OS X when you believe it’s in 
error or you really need that disk off the 
Desktop. (Warning! Ejecting disks that are truly 
in use can corrupt open documents.) [GF]

Bigger iChat Theater — We’ve always liked 
iChat Theater, a way to push a presentation, 

pictures, or other Quick Look-supported media 
to a remote party – we use this for presentations 
with user groups, among other purposes. In 
Snow Leopard, Apple says you can now push 
iChat Theater – and any iChat video – at up to 
640 by 480 pixels while using as little as 300 
Kbps upstream, about a third of the previous 
requirement for a lower resolution.

Jeff Carlson shared a PDF with me via iChat 
Theater, and the text was clearly readable. Pages 
instantly refreshed as he flipped through the 
PDF on his end. [GF]

Location via Wi-Fi — Apple can now set your 
time zone via Wi-Fi, most likely using the 
Skyhook Wireless positioning system that’s also 
part of the iPhone OS. Bring up the Date & Time 
preference pane, click the Time Zone view, and 
check the Set Time Zone Automatically box.

A progress spinner shows up while Snow 
Leopard sends information off about Wi-Fi 
signals in your vicinity and receives data back. 
I’ve seen this both fail and succeed, but usually 
Mac OS X quickly tells me I’m in Seattle 
(whew). [GF]

Wake on Demand — Putting your Mac to sleep 
saves power, but it also disrupts using your 
Mac as a file server, among other purposes. 
Wake on Demand in Snow Leopard works in 
conjunction with an Apple base station to 
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continue announcing Bonjour services that the 
sleeping computer offers.

The requirements are complex. You must have 
firmware release 7.4.2 installed on either an 
AirPort Extreme Base Station or Time Capsule. 
If WPA or WPA2 encryption is turned on, the 
base station can’t be in bridge mode. Only 
newer computers – every 2009 model and at 
least several 2008 models – can be woken over 
Wi-Fi; all Macs can be woken via Ethernet. 
Apple provides more details in a support note, 
and our Glenn Fleishman wrote a long article 
with the ins and outs for Macworld.

You toggle this feature in the Energy Saver 
preference pane. It’s labeled Wake on Network 
Access for computers that can be roused either 
via Wi-Fi or Ethernet; Wake on Ethernet Network 
Access or Wake on AirPort Network Access for 
wired or wireless only machines, respectively. 
Uncheck the box to disable this feature. [JLC]

Exposé Shortcuts — As one of the few feature 
changes in Snow Leopard, you’ve probably seen 
how Exposé now works from the Dock, 
arranges windows in an easier-to-read layout, 
and enables you to move content between 
applications. Here are a few shortcuts that will 
make Exposé even more useful:

• With all windows visible (press F9 or the 
Exposé key [F3] on recent Mac laptops), press 
Command-1 to arrange the windows by 
name.

• Also with all windows visible, press 
Command-2 to arrange them by application.

• Press the Tab key to view all windows 
belonging to one application (equivalent to 
pressing F10 or Control-F3 on recent laptops). 
Press Tab again to switch between 
applications while remaining in Exposé. You 
can also click an icon in the dock.

• Hover your mouse pointer over a window 
and press the spacebar to view a larger Quick 
Look version of that window. [JLC]

iCal’s New Inspector — Admittedly, this new 
feature feels more like a workaround hack than 

a solution, but we’ll take it. The Leopard 
version of iCal made editing events more 
difficult than in the Tiger version. To view 
details about an event, for example, you must 
double-click the event to reveal only some 
information in a pop-up box; you then need to 
click the Edit button (or know to press 
Command-E) to edit an item’s information. In 
contrast, iCal in Tiger provided an optional 
drawer to reveal and edit those details. In Snow 
Leopard, choose Edit > Show Inspector (or 
press Command-Option-I) to bring up a floating 
Inspector that provides an editable view of any 
items selected in your calendar. [JLC]

Screenshots Named Better — Gone are the 
inscrutable “Picture 1” files on your Desktop. 
Snow Leopard instead names screenshots taken 
with the built-in screenshot feature along these 
lines: “Screen shot 2009-08-31 at 12.57.39 PM.” 
Wordy, but it gives you a slightly better sense of 
what might be inside. [GF]

240 Pages of Snow Leopard Details — 
Available the day that Snow Leopard was 
released, Jeff Carlson’s latest book, “The Mac 
OS X 10.6 Snow Leopard Pocket Guide,” 
includes details like these as well as a great 
overview of Mac OS X, all in just 240 pages of 
clear text and screenshots. The book retails for 
$14.99, and is available in bookstores and at 
Amazon.com (currently discounted to just 
$10.19). (A downloadable excerpt should be 
available from Peachpit.com by the time you 
read this.)

Tip of the Iceberg — As we mentioned above, 
these changes are merely the hidden 
refinements that jumped out at us right away 
and demanded to be trumpeted to our readers. 
To learn more about other tweaky changes 
straight from the cat’s mouth (some of which 
are useful; others of which are merely 
marketing points), check out Apple’s Snow 
Leopard Enhancements and Refinements page.
Unless otherwise noted, this article is copyright © 2009 TidBITS 
Publishing, Inc. TidBITS is copyright © 2009 TidBITS Publishing 
Inc. Reuse governed by Creative Commons License.
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Peering Inside Snow Leopard Security
by Rich Mogull 

From the beginning, Apple made it clear that 
Mac OS X 10.6 Snow Leopard was focused on 
improving the performance of the operating 
system and providing developers with new 
tools for harnessing the power of modern 
hardware and multiprocessor systems. The 
included security-related changes are no 
different, and for the most part are completely 
invisible to the user.

These changes provide new tools to assist 
programmers in producing more secure 
applications and harden the core operating 
system, which will result in a safer computing 
experience for most Mac users.

Despite these improvements, Apple missed a 
major opportunity to include a key operating 
system feature that could nearly wipe out a 
entire category of attack.

Securing Memory and the Power of 64-Bit 
Security — The changes I describe here are 
fairly subtle and technical, so those of you who 
don’t care about things like stack versus heap 
memory might want to skip to the next section.

The most significant single improvement is that 
the operating system has now been compiled 
with stack memory protection by default. 
Essentially, this places what’s known as 
“canaries” in stack memory: fixed values in fixed 
locations that are pushed around if an attacker 
uses a buffer overflow attack, enabling the 
operating system or program to detect attacks.

(Buffer overflows happen when input values to 
a program – something as simple as a URL 
entered in the location field of a browser – is 
larger than expected. The data that overflows 
can be used to crash software or a system, or 
gain privileged access.)

Stack memory protection makes an entire class of 
buffer overflow attacks much more difficult to 
exploit, even when a software vulnerability is 
present. Developers will need to enable it for their 

own applications, but by default, Apple uses this 
feature everywhere it can to limit attacks.

A second overarching improvement is the 
migration to 64-bit applications and 
components throughout Snow Leopard. While 
Apple touts 64-bit support largely for its speed 
boosts and to enable memory-hungry 
applications to address more memory, the Intel 
CPU architecture offers substantial hardware 
security capabilities that generally aren’t 
available in 32-bit environments.

While Snow Leopard includes both 32-bit and 
64-bit kernels, it’s possible for a 64-bit capable 
Mac to boot with the 64-bit kernel only under 
Mac OS X Server 10.6 – Snow Leopard Server. 
When running Snow Leopard Server, the 2008 
and 2009 Xserves and Mac Pros boot the 64-bit 
kernel by default; the 2008 and 2009 iMacs are 
capable of booting the 64-bit kernel in Snow 
Leopard Server, but must be placed in that 
mode by holding down the 6 and 4 keys at 
startup. Apple posted a Knowledge Base article 
with details about accessing the 64-bit kernel in 
Snow Leopard Server, but it has offered nothing 
yet for the regular version of Snow Leopard.

Wherever possible, Apple appears to try to use 
new security technologies for Snow Leopard on 
32-bit systems, but most of the real security 
advantages are possible only when running 64-
bit software on 64-bit hardware.

One of the key areas in which this prevents 
trouble is in the heap memory, where Apple 
uses a combination of technologies: one 
leverages 64-bit hardware, while the others are 
software enhancements. (The heap is a pool of 
free memory that applications can dynamically 
use on a temporary basis, as opposed to the 
more-structured and static stack memory.)

When programming an application, heap 
memory locations that should only accept data 
can be marked as non-executable, and this will 
be enforced by a 64-bit processor (similar 
hardware protection has been used since Mac 
OS X 10.4 Tiger for stack memory on 32-bit 
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processors). This, again, increases the difficulty 
of heap-based memory exploits, which are a 
common form of attack.

Apple further hardened the heap through use of 
stronger heap checksums to detect when 
someone has tried to modify a portion of 
memory. Combined with a related feature that 
terminates processes if it detects double null 
bytes where they shouldn’t be, this approach 
doesn’t eliminate all heap based memory 
attacks, but makes the life of the attacker much 
more difficult.

A final advantage of the move to 64-bit code is 
that applications now move data around more 
securely, skipping the stack completely. 
Function arguments are passed via registers, 
which, again, complicates the life of an attacker 
trying to attack your Mac using memory 
corruption techniques.

Sandboxing and Safari Enhancements — 
Sandboxing is the process of restricting what 
kinds of activities an application can perform. 
For example, you can sandbox an application so 
it can read files, but not write them, or restrict it 
from accessing the network. It’s a great way to 
limit the damage if an attacker is able to exploit 
an application on your Mac, since they’ll be 
stuck in the sandbox.

Apple provides sandboxing services that any 
developer can use, and has slowly been 
increasing the number of Apple applications 
that implement sandboxing through software 
updates. Apple continued this trend with Snow 
Leopard, sandboxing a number of new 
applications and features. One example is the 
x264 codec for handling H.264 video, which will 
make it harder for attackers to build malicious 
video files designed to corrupt your video 
player and allow them to exploit your Mac (a 
not-uncommon attack vector).

There’s been discussion over increased 
sandboxing in Safari, but that’s not quite how 
Apple improved browser security and stability. 
Instead of trying to sandbox browser plug-ins 

within Safari, Snow Leopard now runs them as 
separate processes. That way if a plug-in 
crashes, it doesn’t crash your entire browser. (In 
fact, Apple told us that browser plug-ins are the 
number one cause of crashes in Mac OS X, so 
making them independent processes should 
increase general reliability as well.)

Running browser plug-ins as separate processes 
improves security more than just increasing 
sandboxing, because Safari includes support for 
a legacy requirement that allows the use of a 
somewhat less-secure version of a common 
programming function called malloc that’s 
important for memory management. These 
plug-ins now run using the more-secure version 
of malloc used by the rest of Snow Leopard. By 
separating plug-ins into separate processes, 
developers potentially have more opportunities 
to add sandboxing to their plug-ins.

Some WebKit-based plug-ins still run within the 
main Safari process, but most of the major plug-
ins have migrated to this new architecture, 
improving security and stability.

A New Firewall Setting — With Leopard, Apple 
introduced a new firewall capable of restricting 
inbound access to specific applications, not just 
network ports and protocols (see “Leopard 
Firewall Takes One Step Forward, Three Steps 
Back,” 2007-11-05). In Snow Leopard, Apple 
implemented a minor default usability change 
some users will want to disable.

You can find the settings in the Security system 
preference pane in the Firewall view, which 
now provides just a Start or Stop button. If you 
click the Advanced button, the settings are 
nearly identical to those in Leopard, but with 
one minor change: a new checkbox allows 
signed software to receive incoming 
connections automatically.

This setting allows applications signed by a 
valid certificate authority – the same authorities 
that sign Web pages for secure SSL/TLS 
sessions – to receive incoming connections with 
no additional steps. Previously, you would have 
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had to add the application or approve a firewall 
exception when Leopard noted the application 
trying to set up the incoming connection.

This bypass was likely included to reduce the 
number of dialog boxes users need to click 
when installing software from known 
companies. Don’t worry: even if a program is 
allowed by default you can still manually 
change the setting to block access.

Users who want more control over their 
security should disable this setting, since 
anyone willing to pay the money can purchase 
a code signing certificate. Just because a 
program is signed doesn’t necessarily mean you 
want it to accept incoming connections.

New Malicious Software Protection — Back in 
Mac OS X 10.4 Tiger, Apple introduced a new 
File Quarantine feature. Enhanced again in 
Leopard, it displays a warning the first time you 
run any file that was downloaded using 
common Internet programs like Mail, Safari, 
and iChat.

In Snow Leopard, File Quarantine now checks 
these programs to see if they contain certain 
malicious software, which is sometimes hidden 
in downloads to trick users into installing it. If 
the file is infected, you’ll see a new warning that 
explicitly warns you the file is dangerous.

Right now, according to reports on the Internet, 
the feature only checks for two known types of 
malicious software. Apple has stated that 
additional checks can be added using the 
normal Software Update approach if needed.

This doesn’t mean that Apple has added 
antivirus software to your Mac. Using File 
Quarantine will protect you from running a few 
specific instances of malware downloaded 
using standard programs, but won’t catch other 
malicious files, such as any transferred via USB 
drive. The feature also won’t necessarily protect 
you if an attacker exploits your Mac, such as 
through a Web browser vulnerability, and then 
uses that toehold to install additional malicious 

software. And it can’t remove the infection from 
compromised files.

The initial version offers Apple a great 
capability to push out protection to users in case 
a larger infection starts to propagate. (For 
detailed information on how the enhanced File 
Quarantine feature works, we recommend Dan 
Moren’s excellent article at Macworld.

A Missed Opportunity — One major 
disappointment in the midst of all these security 
enhancements is that Apple did not improve the 
Library Randomization feature introduced in 
Leopard. Also known as ASLR, and found in 
Windows Vista and Windows 7, it’s a powerful 
operating system security technology that 
nearly eliminates the memory-based attacks 
we’ve spent so much time talking about.

Library Randomization picks different memory 
locations for key operating system components 
each time the system starts up. Even if an 
attacker exploits a vulnerability on your system, 
it is nearly impossible for them to tie into the 
operating system and actually do anything 
malicious (or otherwise) because they can’t rely 
on where the hook can be found.

Library Randomization in Leopard and Snow 
Leopard does shift around some important 
pieces of the operating system, but leaves the 
memory location of one key component static 
across all Macs (dyld, the dynamic loader). With 
dyld in place, an attacker has a roadmap to 
continue their exploitation and potentially take 
over your system.

Randomizing the location of dyld is no small 
task, but Apple had a perfect opportunity to 
make the change with Snow Leopard, since so 
many other important parts of the operating 
system were being updated. Combined with the 
64-bit enhancements, it would make memory 
exploitation of any type extremely difficult and 
provide years of worry-free Mac computing.

Continually Improving Security — Snow 
Leopard also includes a few other small 
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changes. Users concerned with privacy can 
disable location services in the Security 
preference pane (in the General view, check 
Disable Location Services). As on the iPhone and 
iPod touch, location services allow your current 
coordinates – derived via Wi-Fi signals as well 
as future GPS hardware – to be used by system 
components and third-party software. Date & 
Time, for instance, now uses Wi-Fi signal 
snapshots to set your time zone automatically.

Apple also increasingly phased out the use of 
the setuid function in the operating system, 
which reduces security by running processes 
under administrative or other user accounts.

It’s important to remember that Apple has 
gradually been enhancing security, sometimes 
with major enhancements, through Software 
Update long before the release of Snow 
Leopard. Sandboxing, increased stack memory 
protection, reducing use of setuid, adding anti-
phishing to Safari, and a series of other changes 
have found their way onto our Macs outside of 
major operating system version updates.

Overall, Snow Leopard is more secure than 
Leopard, although Mac users on 32-bit 
processors won’t see all the benefits.

Still, I am extremely disappointed that Apple 
failed to complete Library Randomization. 
Microsoft has experienced significant real-world 
security benefits with their adoption of ASLR, 
and had Apple taken this step they would have 
practically eliminated memory-based attacks 
like buffer overflows.

Although most of the security enhancements in 
Snow Leopard are hidden deep within the 
operating system, they should provide practical 
benefits to all Mac users on 64-bit architectures. 
While the only true test of security is how 
effective it is in the real world, on paper it looks 
like life is now at least a little harder for any 
potential Mac attackers.
Unless otherwise noted, this article is copyright © 2009 TidBITS 
Publishing, Inc. TidBITS is copyright © 2009 TidBITS Publishing 
Inc. Reuse governed by Creative Commons License.

iTunes 9 
Refines 
Crowdsourcing 
and Sharing 
Features
by Adam C. Engst 

At the special Rock and Roll event today 
[Sept. 8, 2009], Apple unveiled a new version of 
the near-ubiquitous media application iTunes. 
The latest version introduces a variety of 
features, including some that respond to user 
requests and others that are clearly just what 
Apple (or Steve Jobs, who was back on stage 
with a much younger liver) wants to see.

As usual, Apple touted the success of the iTunes 
Store, boasting about how it’s now available in 
23 different countries and hosts over 100 million 
iTunes accounts. Those users have purchased 
8.5 billion songs so far, making iTunes one of 
the largest stores on the Web, and the top music 
retailer in the world.

It will take some time with the software to wrap 
our heads around the new features in iTunes, 
since Apple’s demo of them was relatively brief, 
but they include the following:

• Genius Mixes: With the Genius feature of 
iTunes having processed 54 billion songs from 
27 million libraries, Apple has accumulated a 
massive database of user information. The 
company has now tapped that information to 
create Genius Mixes, which makes up to 12 
endless mixes of songs that go well together. It 
may be as close as you get to being like author 
Stephen King and owning your own radio 
station that plays only music you like.

• Improved Syncing: We imagine there will be 
additional details about this to ferret out, but 
Apple claims to have improved syncing with 
a new Music tab that lets you choose playlists, 
artists, or genres for automatic syncing. 
Previously, that required setting up smart 
playlists. Plus, the Photos tab will let you sync 
events and faces from iPhoto.
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• App Arranging: Tired of dragging icons 
around on your iPhone or iPod touch? Us too. 
Luckily, that won’t be necessary any more, 
since iTunes 9 enables you to arrange apps – 
and entire screens – on your Mac, where it’s a 
much more fluid environment. About time!

• Home Sharing: Here’s another potentially 
major feature that will require some 
exploration. In the past, iTunes has allowed 
you to “share” libraries with other users on 
your network, but that sharing involved only 
the streaming of music. You couldn’t copy 
songs around, rate them, add them to 
playlists, or anything else useful. The new 
Home Sharing feature does away with those 
limitations, for up to five computers on your 
local network. Most notably, you’ll be able to 
copy songs, movies, TV shows, and even 
iPhone apps from other computers on your 
network.

• iTunes LP: Luckily, the TidBITS audience 
understands what an LP is, so we won’t have 
to offer a history lesson like all the fanboy 
sites. The point of the iTunes LP feature is to 
provide lyrics, photography, liner notes, and 
more – all the sorts of things that artists did 
for record albums because they had the space. 
Those details largely went away with CDs, 
and have fallen almost entirely by the wayside 
with digital music. The question is whether 
the iTunes LP content will be compelling for 
customers, or if it’s more designed to involve 
artists in the iTunes Store – bringing them into 
the Apple orbit, as it were. Plus, because 
iTunes LP content is available only with 
album purchases, it may help assuage artist 
concerns about iTunes selling mostly 
individual tracks, rather than entire albums. 
It’s unclear whether or what the upgrade cost 
will be for those who already own albums that 
get the iTunes LP treatment.

• iTunes Extras: Where iTunes LP brings extra 
album content to music, iTunes Extras brings 
additional materials to movies. This may 
enable iTunes to compete better with DVDs 

from Netflix, for instance, for those people 
who enjoy watching all the extra content. As 
with iTunes LP, it’s not yet clear what the 
upgrade cost will be (or if it will be available) 
for those who previously purchased movies 
that now offer extras.

• Redesigned iTunes Store. We seldom comment 
on the design of the Apple Web site, and 
similarly, the design of the iTunes Store 
doesn’t feel like the sort of thing that requires 
coverage and analysis. Apple says they’ve 
made new artist pages, new movie pages, new 
TV show pages, improved navigation, and an 
overall cleaner layout.

As always, iTunes 9 is free, and is available now 
as a 82.8 MB download; it should appear in 
Software Update soon. It requires Mac OS X 
10.4.11 or later, although the iTunes LP and 
iTunes Extras features need Mac OS X 10.5 or 
later. It does work on older PowerPC G4- and 
G5-based Macs, but with some limitations for 
video playback.

Apple also released iTunes 8.2.1 for PowerPC 
G3-based Macs; it’s a 77.3 MB download and 
presumably has been updated purely for 
compatibility with Apple’s back end 
infrastructure and new hardware.
Unless otherwise noted, this article is copyright © 2009 TidBITS 
Publishing, Inc. TidBITS is copyright © 2009 TidBITS Publishing 
Inc. Reuse governed by Creative Commons License.
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Hot Links of the Month
Compiled by Ron Heck

Editorʼs Note: Since the biggest news of the month is 
clearly the release of the new Mac OS, the next page 
and a half is dedicated to all things Snow Leopard.

Mac OS X 10.6 Snow Leopard

Installing Snow Leopard: What you need to 
know | MacWorld
http://tinyurl.com/p5j899

How-To: Upgrade To Snow Leopard — The Right 
Way | Cult of Mac
http://tinyurl.com/kqx5yn

Review: Snow Leopard | MacWorld
http://tinyurl.com/kqt2vv

Apple Mac OS X Snow Leopard | CNET
http://tinyurl.com/nmv2fe

Apple Changes Leopard’s Spots | Wall Street 
Journal
http://tinyurl.com/m489wx

Mac OS X 10.6 Snow Leopard: the Ars Technica 
review | Ars Technica
http://tinyurl.com/mm5fn4

Review: Apple Snow Leopard a speedy no-
brainer upgrade | Chicago Sun-Times
http://tinyurl.com/kj9uxt

Snow Leopard Review: Lightened and 
Enlightened | Gizmodo
http://tinyurl.com/mmygug

What’s New in Snow Leopard | TidBits
http://db.tidbits.com/article/10504

Inside Mac OS X Snow Leopard: 
64-bits | AppleInsider
http://tinyurl.com/mp7p39

Snow Leopard’s smaller changes | MacWorld
http://tinyurl.com/q4jpve

Snow Leopard: QuickTime X | MacWorld
http://tinyurl.com/kturjq

Inside Mac OS X Snow Leopard: QuickTime X | 
AppleInsider
http://tinyurl.com/nmd2zd

Giz Explains: Snow Leopard’s Grand Central 
Dispatch | Gizmodo
Under the hood is a feature called Grand 
Central Dispatch which helps the computer 
manage multiple tasks. Gizmodo provides a 
detailed analysis of GCD.
http://tinyurl.com/lbyeo4

15 Snow Leopard Tricks You Have to Try | 
Gizmodo
http://tinyurl.com/mlpo2t

Services step out in Snow Leopard
The often overlooked Services feature that was 
already a part of the Mac OS received a new 
look.
http://tinyurl.com/krses2

How to create a Service in Snow Leopard
MacWorld
http://tinyurl.com/r6choy

Snow Leopard’s old and new annoyances
MacWorld
http://tinyurl.com/ldldsb
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Snow Leopard (continued)

Everything You Wanted To Know 
About Apple’s New Anti-Virus 
Spotter | Cult of Mac
http://tinyurl.com/m8rdvm

Reveal hidden menu bar icon functions in Snow 
Leopard | MacWorld
http://tinyurl.com/lgrwm5

Snow Leopard: What’s gone where | MacWorld
http://tinyurl.com/pv6fjn

Snow Leopard’s System Preferences shuffle | 
MacWorld
http://tinyurl.com/mp4emk

A Closer Look at Snow Leopard’s Wake on 
Demand Feature | MacRumors
http://tinyurl.com/lx77x8

How to use text substitution in Snow Leopard | 
MacWorld
http://tinyurl.com/o54u9f

Snow Leopard versus Windows 7 | MacWorld
Hot on the heels of Snow Leopard, Microsoft 
will release its new OS called Windows 7. 
MacWorld examines how they match up.
http://tinyurl.com/ko5nmd

OS deathmatch: Snow Leopard vs. Windows 7 | 
Computerworld
http://tinyurl.com/ldegfc

Hot Links of the Month (continued) iPod/iPhone/iTunes

iTunes 9 Review | Macworld
http://tinyurl.com/mpoe6s

Instant Expert: Secrets & Features of iTunes 9 | 
iLounge
http://tinyurl.com/pwazw2

5 ways to listen to music on the iPhone without 
using iTunes | Ars Technica
http://tinyurl.com/kuab2z

Instant Expert: Secrets & Features of 
iPhone 3.1 | iLounge
http://tinyurl.com/knvof6

Apple’s fifth take: Ars reviews the iPod nano 
with video| Ars Technica
http://tinyurl.com/nsdbxk

Apple rivals DVD with new iTunes Extras for 
movies and albums | AppleInsider
http://tinyurl.com/n5pund

iPod Nano 5th Gen Review | Gizmodo
http://tinyurl.com/qktlj4

Fifth-generation iPod nano Review | Macworld
http://tinyurl.com/q2yow2

Miscellaneous

Parallels Desktop for Mac Targets “Switchers” 
with Special Edition | Cult of Mac
http://tinyurl.com/qdtuj2

Save money with your Mac | Macworld
http://tinyurl.com/l67w7e

MobileMe proving to be valuable to theft 
victims | Ars Technica
http://tinyurl.com/nzu5lq

Everything you ever wanted to know about 
MacHeist | Edible Apple
http://tinyurl.com/pwzmsq
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Members Helping Members
Need Help? Have a question the manual doesn’t answer? Members Helping Members is a group of 
volunteers who have generously agreed to help. They are just a phone call or an email away. Please 
call only during the appropriate times, and only if you are a current mini’app’les member and own 
the software in question.

............Apple II / IIGS Software & Hardware 1, 2
...............................AppleWorks / ClarisWorks 3, 4

Classic Macs
.............................Cross-Platform File Transfer 2, 3

FileMaker Pro
iMacs
Intel-Based Macs

.......................................................................iPhoto 3
iTunes / iMovie

........................................................................iWork 4
........................................................Mac OS Classic 3

Mac OS X

................................................Microsoft Excel 2, 5, 7
...................................................Microsoft Word 2, 7

.......................................................................MYOB 5
Networks

...............................................................New Users 1
PhotoShop

............................................................QuarkXPress 7
....................................................................Quicken 5

........................QuickBooks and QuickBooks Pro 5
.............................................................VectorWorks 6

1. Les Anderson 651-735-3953 anderslc@usfamily.net DEW
2. Tom Ostertag 651-488-9979 tostertag@usfamily.net EW
3. Bruce Thompson 763-546-1088 bthompson@Macconnect.com EW
4. Pam Lienke 651-457-6026 plienke@aol.com DEW
5. Ardie Predweshny 612-978-9774  DEW
6. Charles Radloff 952-941-1667  D
7. Ron Heck 651-774-9151 ronheck@comcast.net DEW

D = Days, generally 9 am to 5 pm
E = Evenings, generally 5 pm to 9 pm
W= Weekends, generally 1 pm to 9 pm

Please call at reasonable hours and ask if it is a convenient time for helping you. By the way, many of 
these volunteers can also be contacted on our forums. We appreciate your cooperation.

mini’app’les needs more volunteers for Members Helping Members — If you are willing to be a 
Members Helping Members volunteer, please send an email message to Membership Director Les 
Anderson or contact him on our forums with your name, telephone number, contact hours, and the 
software and hardware areas you are willing to support.
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mini’app’les Membership Application and Renewal Form
Membership cost is $15.00 for one year. Please make your check payable to “mini’app’les”.

Name:     

Company (if mailed to):     

Address:    

City, State, Zip:     

Phone # (home):     

Phone # (work):     

Phone # (cell):     

Occupation (if applicable):     

Membership ID # (if renewal):     

Email:     
Your email address will NOT be sold, shared, or distributed. It will be used only for official mini’app’les business such as distribution 
of the newsletter and membership renewal reminders.

   Check if this is a change of address notice

   Check if you want to volunteer

   Check if you want to be added to “Members Helping Members”

   Check if you were referred by a club member (if so, please give member’s name)

Please mail this application and your payment to:
mini’app’les
P.O. Box 796
Hopkins, MN 55343-0796

Thank you for your support!

Benefits of mini’app’les Membership

• Access to the mini’app’les online forums. Post questions and/or answers about issues, trouble shooting, 
products, buying and selling, special events, discounts, and news about Apple and the mini’app’les club.

• Access to our Members Helping Members network of professional and advanced users of Apple technologies. 
These members volunteer their time to help other members with software, hardware, and other Apple related 
issues.

• A variety of Mac Special Interest Groups (SIGs) that meet each month.

• Multi-SIG meetings and workshops to help members with computer problems. You can bring your equipment 
to these events and receive support from knowledgeable Mac users to help diagnose your problem(s).

• Participation in drawings for computer hardware, software, and other computer related materials.

• Discounts from vendors and manufacturers. Refer to the on-line forums for current offers.
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mini’app’les
the minnesota apple computer users group, inc.

Introduction — This is the newsletter of mini’app’les, the 
Minnesota Apple Computer Users’ Group Inc., a Minnesota 
non-profit club. The whole newsletter is copyrighted © by 
mini’app’les. Articles may be reproduced in other non-profit 
User Groups’ publications except where specifically copyrighted 
by the author (permission to reproduce these articles must be 
given by the author). Please include the source when reprinting.

The mini’app’les Newsletter is an independent publication not 
affiliated, sponsored, or sanctioned by Apple, Inc. or any other 
computer manufacturer. The opinions, statements, positions, and 
views are those of the author(s) or newsletter staff and are not 
intended to represent the opinions, statements, positions, or 
views of Apple, Inc., or any other computer manufacturer. 
Instead of placing a trademark symbol at every occurrence of a 
trade-marked name, we state we are using the names only in an 
editorial manner, to the benefit of the trademark owner, with no 
intention of infringement of the trademark.

Questions — Members with technical questions should refer 
to the Members Helping Members section or bring their 
questions to an appropriate SIG meeting. Please direct other 
questions to an appropriate board member. 

Dealers — mini’app’les does not endorse specific dealers. The 
club promotes distribution of information that may help 
members identify best buys and service. The club itself does not 
participate in bulk purchases of media, software, hardware, and 
publications. Members may organize such activities on behalf of 
other members.

Newsletter Contributions — We welcome contributions 
from our members. Please send contributions directly to our 
post office box (mini’app’les, PO Box 796, Hopkins MN 
55343), email them to miniapples@mac.com, or email them to 
the newsletter editor at ronheck@comcast.net

The deadline for material for the next newsletter is the fifteenth 
of the month. An article will be printed when space permits and, 
if in the opinion of the Newsletter Editor or Publications 
Director, it constitutes material suitable for publication.

This newsletter was produced using Apple’s Pages word 
processor.

Board of Directors
President Bruce Thompson
 763-546-1088
 bthompson@macconnect.com

Vice President Tim Drenk
 952-431-3978
  tim@drenkconsulting.com

Secretary Harry Lienke
 651-457-6026
 plienke@aol.com

Treasurer Dave Lundin
 715-483-3776
 cdlundin@centurytel.net

Membership Director Les Anderson
 651-735-3953
 anderslc@usfamily.net

Publications Director Ron Heck
 651-774-9151
 ronheck@comcast.net

SIG Director Kevin Strysik
 65l-489-4691
 strysik@mac.com

Director at Large Tom Gates
 612-789-1713
 tgates@isd.net

Membership  Sandy Foderick
Coordinator sfoderick@mac.com
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